
Table of Contents
-----------------------------Projects and Actions: planning what needs to be done
 1

--------------------------------------------------------How projects, actions, and contexts work together
 1
----------------------------------------------------------------------------------------------Creating a project
 1

-----------------------------------------------------------------------------------Adding actions to a project
 1
--------------------------------------------------------------------------------Assigning contexts to actions 
 2

----------------------------------------------------------Attaching files and notes to actions and projects 
 2
------------------------------------------------------------Keeping track of the next action in each project
 2

----------------------------------------------------------------------Making a project sequential or parallel
 2
-------------------------------------------------------------------------------------------Using action groups 
 2

------------------------------------------------------------------------------Organizing projects into folders
 3
---------------------------------------------------------------------------Setting start dates and due dates 
 3

------------------------------------------------------------------Setting up repeating actions and projects 
 3
------------------------------------------------------------------------------------Using the Action inspector
 4
-----------------------------------------------------------------------------------Using the Project inspector
 4
----------------------------------------------------------------------------------Using the Context inspector
 4

------------------------------------------------------------------------------------Estimating action duration
 4
------------------------------------------------------------------------------------Marking actions complete
 4

--------------------------------------------------------------------Flagging important projects and actions 
 5
------------------------------------------------------------------------------Keeping track of single actions 
 5

---------------------------------------------------Contexts: where the work happens
 5
---------------------------------------------------------------------------------------------Creating contexts 
 5

---------------------------------------------------------------------------Organizing contexts hierarchically
 5
-----------------------------------------------------------------------------------Viewing actions by context
 6

-------------------------------------------------------------------------------------------------Context states
 6

----------------------------------------------------------Collecting stuff as it appears 
 6
-----------------------------------------------------------------------------------Dropping stuff in the Inbox
 6

---------------------------------------------------------Using the Quick Entry window
 6
---------------------------------------------------------------------------------------Processing inbox items 
 7

----------------------------------------------------------------------------------------------------Cleaning Up
 7

---------------------------------------------------Searching, focusing, and reviewing
 8
---------------------------------------------------------------------Focusing on certain projects or folders 
 8

--------------------------------------------------------------Using the view bar to filter and arrange items
 8
----------------------------------------------------------------------------Searching for actions or projects
 9

-------------------------------------Using Perspectives to remember your OmniFocus window settings 
 9
--------------------------------------------------------------------------------------------Reviewing projects 
 9

-----------------------------------------------------------------------------------Marking a project complete
 9
------------------------------------------------------------------------------------Putting a project on hold
 10

-------------------------------------------------------------------------------------------Dropping a project
 10

--------------------------------------------Getting data into and out of OmniFocus
 10
Printing
10

------------------------------------------------------------------Clipping material from other applications
 10
--------------------------------------------------------------------------------------Synchronizing with iCal
 10
-------------------------------------------------------------------------------------Using the web interface
 10

Name of report
 i



Projects and Actions: planning what needs to be done

How projects, actions, and contexts work together
Actions — In OmniFocus, the things you need to do are represented as actions. Ideally, an action is a distinct chunk of work that starts 

with an unambiguous verb. This makes things less intimidating to start, and easier to finish: a list of ten actions such as "Carry boxes out 

the recycling bin" and "Assemble bookshelf" is much more approachable than "Finish moving in". Of course, you should find the level of 

specificity that works best for you. As you create actions and move them around, OmniFocus keeps track of which ones are available, 

waiting on something else, or complete.

Projects — Related actions are grouped into projects, which represent a set of actions that are working toward a common result. Anything 

you want to do that requires more than one action, like "Finish moving in" or "Get novella published", are good candidates for projects. 

Projects can then in turn be organized into folders, for keeping track of your broader areas of work.

Single Action Lists — Some actions don't really fit into any particular project; they're just individual little things you need to do. You can 

put this kind of actions into single action lists. They are similar to projects, but they don't assume that the actions they contain have 

anything to do with one another.

Contexts — It’s handy (or, for some people, crucial) to assign a context to each action. A simple way to think of contexts is as the place or 

mode you need to be in to do a given task: you can only make phone calls when you’re near a phone, you can only buy groceries when 

you’re out running errands, and you can only do research on the web when you’re at your Mac. These are contexts; if you think about it, 

almost any task requires you to be in a certain context to do it. You can use Project mode and Context mode to look at your actions in 

terms of what project they belong to or what context they require.

Creating a project
You can make a project any time you realize you have something that you need to do which requires more than one step.

To create a project:

•Make sure you are in Project mode; the view switcher in the toolbar should have the Projects icon highlighted: 
•Click the plus button at the bottom of the sidebar.
•Type a title for your new project.

Regardless of which view mode you are in, you can also create a new project by clicking the Add Project button in the toolbar, choosing 

Add Project from the Structure menu, or typing Command-Shift-N. OmniFocus switches to Project mode automatically.

Adding actions to a project
You can add as many actions as you want to a project, at any time.

To add an action to a project:

•Make sure you are in Project mode; the view switcher in the toolbar should have the Projects icon highlighted: 
•Select the project, either in the sidebar or in the main outline, by clicking the index-card icon next to its name. Or, select an already-
existing action in the project.
•Press Return, or click the Add Action button in the toolbar; the new action appears immediately after the item you selected.
•Type a name for your new action.
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You can move an action between projects by clicking its bullet and dragging it to its new location. You can even turn an action into a project 

by dragging it to the top level of the outline or the sidebar.

Assigning contexts to actions
Any action requires some sort of resources, whether it's the Mac on your desk, the phone in your pocket, or even just a few moments of 

peace and quiet. So for each action, you can assign a context that indicates what you need in order to complete it.

To assign a context in Planning mode:

•Click or Tab into the Context column of an action.
•If the context you want has already been created, click the pop-up arrow or press the Space bar. A menu appears, listing all of your 
contexts; just click the one you want. Once you are used to OmniFocus, you can just type a couple of letters from the context you 
want, and OmniFocus guesses which context you mean; just press Return to confirm it.
•If you need to create a new context, type its name and then press Command-Return to confirm it.

To assign a context in Context mode, just drag an action into the context's entry in the sidebar.

Attaching files and notes to actions and projects
<no data yet>

Keeping track of the next action in each project
Any active project keeps track of the next action that you have yet to complete, and styles it differently from the other actions—by default, a 

project's next action is purple. This is useful for figuring out what you ought to do to keep your projects moving forward.

When you are interested in next actions, you can just look out for the purple actions in your outline. Or, you can hide all but the next actions 

by using the view bar: show the view bar by clicking its icon in the toolbar, then choose Next from the action filtering pop-up menu.

For sequential projects, where you need to do one thing before another, the next action is the only thing you can do right now to make 

progress on the project. For parallel projects, where you can do the actions in any order, the next action is just the first action in the list, and 

acts as more of a suggestion of what you might want to do next.

Making a project sequential or parallel
Some projects consist of actions that can be done in any order, like picking up items at a few different shops; these are parallel projects. 

Other projects require one action to be done before the next one can be started; these are sequential projects. In a parallel project, all 

incomplete actions are available, and the "next action" is just the first one in the list. In a sequential project, only the next action is available.

Task groups are always sequential (but they can be put inside a parallel project). Each task group only ever provides one available action at 

a time.

Whether a project is sequential or parallel is shown by the pair of arrows by the right side of its row in the outline. To switch to the other 

state, just click the icon. You can also choose a state from the Project inspector.

Using action groups
The actions in a project can be organized hierarchically. This is useful for keeping track of complicated projects, or breaking actions into 

smaller actions without creating a whole separate project.
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Another use for groups is when you want to make a new project from the inbox. Set up an action group, then drag it from the inbox to the 

sidebar. The parent action becomes the project, and the child actions become the actions of that project.

If you mark an action group as complete, all of its child actions are also marked as complete.

To give an action some child actions, thus turning it into a group:

•Select the action you want to be the parent of the new group.
•Choose Add Child from the Structure menu, or press Command-}.

To create a group from some existing actions:

•Select all of the actions you want to group.
•Choose Group from the Structure menu, or press Command-Option-L.

Also, you can indent some actions to make them children of the action immediately before them in the outline:

•Select the actions you want to indent, making sure that there's an action before them in the outline.
•Choose Indent from the Structure menu, or press Command-], or click one of the items' handles and drag to the right.

Organizing projects into folders
Folders are a convenient way of separating your projects, the same way you use folders to organize files on your Mac. For example, you 

could keep folders for each area of your life: perhaps Home, Work, Health, Education, and Recreation. That way, when you're concentrating 

on one area, you can keep just that folder expanded in the sidebar, or use the Focus feature to hide the others completely.

To create a folder:

•Make sure you are in Project mode; the view switcher in the toolbar should have the Projects icon highlighted: 
•Click the Add Folder button below the sidebar.
•Name your new folder.

To put something (a project or another folder) inside your folder, just drag its icon onto the folder in the sidebar. You may have as many 

layers of folders as you can stand.

Setting start dates and due dates
Actions and projects can have start dates and due dates. A start date determines when an action or project becomes available, while a due 

date is just a label that signifies when you think the item ought to be completed.

Start and due dates can be entered either in the main outline (if you have the date columns turned on in General Preferences) or in the 

Dates inspector.

You can group and sort by start or due dates with the View Bar.

You can be pretty creative with the way you enter dates; OmniFocus is rather smart about guessing what you mean. For example:

•2d, -3 weeks, 1h, and so on — Relative dates and times put the date at a certain amount of time from right now.
•yesterday, tomorrow, next thursday, last month, and so on — You can refer to dates using common words.
•september, thurs, 2019, and so on — If you enter the name of a specific time period, the date will be at its beginning; So 
september means midnight on the morning of September first.
•9, 14:00, tom, and so on — OmniFocus makes its best guess at things like bare numbers, times, and word fragments. If you think 
something might work, give it a try. We may have thought of it.

Setting up repeating actions and projects
When you have something that needs to be done more than once, you can set it up as a repeating action or project.
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•Open the Repeat inspector; if the inspectors are not already on your screen, you can get at them from the Inspectors menu or by 
clicking the Inspectors button in the toolbar.
•Select the item you want to repeat, then click the Repeat checkbox in the inspector.
•Enter a repeat interval.
•Choose how to count the repeat interval. You can count from the original assigned date (for something that has to happen regularly, 
like paying the rent) or from the completion date (for something that needs to happen a certain time after the last time you did it, like 
getting a haircut).

When you mark a repeating item as complete, the next instance of it is created with its start and due dates pushed forward as indicated by 

the Repeat interval. If you want an item to stop repeating, turn off the Repeat setting in the inspector.

Using the Action inspector
The Action inspector is a central place for changing the attributes of actions. You can use it to set the context, project, or estimated time of 

one or many selected actions.

Open the Action inspector; if the inspectors are not already on your screen, you can get at them from the Inspectors menu or by clicking 

the Inspectors button in the toolbar.

Using the Project inspector
<blank>

Using the Context inspector
<blank>

Estimating action duration
If you like, you can note how long you expect actions to take. Then, when you're looking for something to do, you can choose based on 

how much time you have available.

To turn on the time estimate column in the main outline:

•Choose Preferences from the OmniFocus menu.
•In the Columns section, select Show Estimated Hours Column.

To assign a time estimate, click in the Estimated Hours column for an action, then type a duration. By default, the numbers you type are 

interpreted as minutes (5m and so on). You can also type larger units, such as hours (h) and days (d).

To organize actions based on their estimates, use the View Bar. If the View Bar isn't on, click its icon in the toolbar FilterInactive, or choose it 

from the View menu. To see only actions that match a certain time estimate, choose the duration you want from the time estimate pop-up 

menu. To sort actions by their time estimates, choose Time from the sorting pop-up menu.

Marking actions complete
When you've finished an action, just click its checkbox; its status changes to "completed". If it was the project's next action, another next 

action gets chosen in its place.

Another way to mark something complete is to select the whole row and press Space. You can also right-click any number of selected 

items and choose "Complete" from the contextual menu.

If you mark a whole group complete, all of its child actions become complete too.

Remember that regardless of the actions they contain, projects stay active until you explicitly complete them, by using either the Project 

inspector or the right-click contextual menu.
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Flagging important projects and actions
On the right end of any project or action row, there's a little flag that you can turn on or off. The flag has no inherent meaning of priority or 

anything special like that, so you can use it however you like. You could, for example, mark all of the things you'd like to get done before 

lunch, topics for a meeting you're about to present at, or projects to reconsider the next time you have a chance to think about them. It's 

entirely up to you.

To flag a project or action, click the little flag on the right side of the project or action row in the main outline. You can also select any 

number of actions and projects and then choose Set Flag from the Edit menu, or click the corresponding toolbar button.

If you flag a project, all of its actions get an implicit "ghost" flag, and are treated as if they were flagged themselves. You can still flag them 

individually, too.

Keeping track of single actions
Sometimes you need to do something that doesn't really fit into a project. "Make rosemary lemonade" or "Buy a new cowboy hat", for 

example, probably don't contribute to the completion of any particular project. To keep track of such actions, you can use single action lists.

To create a single action list:

•First, make sure you're in Planning mode. Click the mode switcher in the toolbar , or choose Planning from the 
View menu.
•Choose Add Single Action List from the Structure menu or from the action menu Action Menu below the sidebar.
•Enter a name for your new list, and drag it to wherever you'd like to keep it.

You can keep any number of single action lists; some people like to make one for each top-level folder in their library. Others make a 

"Reading" list, a "Shopping" list, and so on. Single action lists are similar to projects; you can drag them into folders, add actions to them 

from the Inbox, and so on. They are different in a few ways, though:

•Single action lists are always parallel; the actions in them don't block each other from becoming available.
•All single actions count as "next actions", since each one is kind of a little tiny project in itself.

Contexts: where the work happens

Creating contexts
In addition to keeping actions organized into projects, single action lists, and folders, you can also assign each action a context, to indicate 

where you need to be or what you need to have available in order to complete the action.

To create a new context:

•Make sure you are in Context mode; the view switcher in the toolbar should have the Context icon highlighted: Context Mode
•Click the plus button at the bottom of the sidebar.
•Type a title for your new context.

Organizing contexts hierarchically
You can nest a context inside another context, creating a hierarchy as deep as you like. Just drag any context in the sidebar inside of any 

other context.

[screen]

When you select a parent context, you can see all of the actions inside that context or inside any of its descendants. This way you can look 

at your actions assigned to a more general context (like Office) or a more specific one (like Office : Mac). You can also keep identically-

named contexts inside of different parent contexts (like Office : Mac and Home : Mac).
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Viewing actions by context
When you're at the office and ready to get some work done, you probably don't care to see actions that require you to be at the store, at 

home, or at your vacation home in Wisconsin.

To view actions assigned to a particular context:

•Make sure you are in Context mode; the view switcher in the toolbar should have the Context icon highlighted: Context Mode
•In the sidebar, click the context you are interested in. As you select it, only actions assigned to that context appear in the main outline.
•If you like, Command- or Shift-click other contexts to select them at the same time.

To see everything in the main outline again, deselect all contexts by clicking in an empty area of the sidebar or by Command-clicking all of 

the selected contexts.

Context states
<no data>

Collecting stuff as it appears

Dropping stuff in the Inbox
The inbox is a kind of intermediary area between your brain and your OmniFocus library. Whenever you have something important that you 

don't want cluttering up your mind, but you're not quite ready to meticulously file it away in the right place in your OmniFocus structure, just 

put it in the inbox. Later on, when you process the inbox, you can decide whether each item is a new project or an action in an existing 

project, what its context is, and so on.

To create a new inbox item, just select the inbox (in the sidebar or in the main outline) and press Return. Type whatever's on your mind, 

forget about it for now, and get back to whatever you were doing!

You can create hierarchy in the inbox by using the Structure menu commands, if you already know that something is going to have sub-

items. Later, you can add these groups to an existing project or make them into full-fledged projects themselves.

When you are ready to review the things in your inbox, you can process them by assigning them projects and contexts.

Using the Quick Entry window
So the inbox is a quick way to get things off of your mind. But! There's an even quicker way, if you're in the middle of something else and 

you don't want to switch your brain to a different mode: the Quick Entry window.

In the OmniFocus preferences, there's a setting for the Quick Entry keyboard shortcut. This is a key combination which, as long as 

OmniFocus is open, no matter what else you're doing on your Mac at the time, summons up a little window where you can send things to 

OmniFocus.

To collect stuff in the Quick Entry window:

•Press the Quick Entry keyboard shortcut as you have set it in the preferences. By default, it's Control-Option-Space. The Quick Entry 
window appears.
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•Type in the Quick Entry window as if you were typing in the OmniFocus inbox. Create as many items as you want, with as much 
hierarchy as you want. You can enter projects, contexts, dates, notes, and so on for each item.
•When you're done, click the Save button or press Command-S. The items are whisked off to your inbox and you can keep on doing 
whatever you were doing. If you don't want to put the items in your inbox yet, click the Cancel button or press Command-Period, the 
items will still be there the next time you open the Quick Entry window.

Processing inbox items
Items you put in the inbox stay there until you assign them a project or context (using the Action inspector or by typing in the Project and 

Context columns). If you assign both a project and a context, then the next time you clean up the item is filed away where it belongs. 

Depending on your preferences, an inbox item with a project but not a context assigned, or vice versa, may stay in the inbox or may be 

automatically filed somewhere.

Inbox items have both a Project column and a Context column. To assign a project or a context, you can click the pop-up button next to 

the appropriate cell to see a pop-up menu of all available projects or contexts.

Or, you can type directly into the cell. With each letter you type, OmniFocus guesses which of your projects or contexts you mean. Most of 

the time you can get the right one with just a couple of key presses. For example, if you type aak or ado into a project cell, OmniFocus 

would find your Adopt a Kitten project. Once the correct project or context is highlighted, you can just leave the cell.

If you need to create a new project or context, just type its name into the cell and press Command-Return instead of Return. OmniFocus 

creates the new project or context for you, and assigns the action to it.

To move inbox items to your library:

•For an individual action, just assign a project or context to it, then use the Clean Up command in the Edit menu or the Clean Up 
button on the toolbar to move it to its proper place.
•For any inbox item, including groups, you can click its handle and drag it to the sidebar or the main outline wherever you would like it 
to go. Drop it inside a project to add it to that project, or drop it anywhere else to turn it into a project.

Cleaning Up
The grouping, sorting, and filtering settings in the view bar control what parts of your database are visible and how they're arranged. For 

instance, most of the time you don't care to see actions you've already completed, so you use the action filter to show only remaining 

actions. Sure, that's handy, but you also don't want OmniFocus pulling stuff out from under you as you're working on it. For instance, if you 

mark an action complete, you probably don't want it to disappear that very moment; you may still change your mind and want to uncheck 

it, or copy its notes into an e-mail, or just double-check that you clicked the right thing. Likewise, you probably don't want an inbox item to 

be spirited away the instant you assign a context to it.

So, OmniFocus has a command called Clean Up. It happens automatically every now and then, so that things stay tidy, but you can also 

clean up manually by clicking the Clean Up toolbar button, or choosing Clean Up from the Edit menu.
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Cleaning up puts everything where it belongs: items that don't match the filter settings disappear, visible items move into the appropriate 

groups, inbox items move to their assigned projects, and so on. After you change some items, you can Clean Up to make sure that your 

view is up to date.

Searching, focusing, and reviewing

Focusing on certain projects or folders
If you know that you want to concentrate for a while on a particular project, folder, or combination of items, the Focus feature can get 

everything else out of your way.

To Focus:

•Select a project or folder (or any combination of projects and folders) in the sidebar.
•Click the Focus toolbar button, or choose Focus on — from the View menu. Everything outside your selection disappears from the 
sidebar, and the title at the top of the window changes to Focusing on —.
•As you work in Planning mode, or switch to Contexts mode, OmniPlan ignores everything outside of your focus, as if the items you're 
focusing on are the only items in your library.
•When you're done focusing, choose Show All Projects from the View menu, or click the Show All toolbar button. Your library 
comes back as if nothing ever happened!

Using the view bar to filter and arrange items
The view bar is a powerful way to filter and rearrange the items in your window. It has one pop-up menu to control what appears in the 

sidebar, and five pop-up menus to control what appears in the main outline. The various filters work together, so that you can come up with 

quite expressive combinations of settings, like Flagged next actions in active projects, that I can do in less than 15 minutes, sorted by due 

date.

Project Filter

This appears above the sidebar in Planning mode; click it to choose what kind of projects to show in the sidebar. You'll probably want this 

to be Active Projects most of the time, so you can see only the projects you're working on now. You can also choose Pending Projects 

(which would be active but have start dates in the future), On Hold Projects, Dropped Projects, or Completed Projects (which are 

states you can set on a project to remove it from Active Projects).

Context Filter

This appears above the sidebar in Contexts mode; click it to choose what kind of contexts to show in the sidebar. You can choose Active 

Contexts (which only includes contexts that have any actions assigned to them), Available Contexts (which includes any contexts that you 

haven't marked as Hidden), or All Contexts (which includes all contexts whether you have marked them as Hidden or not).

Grouping

Click this to choose how to group the projects in the Planning view outline, or the actions in the Context view outline. You can Ungroup 

everything, or group by Folder (for the same structure as you see in the sidebar), Due date, Start date, Completed date, Next Review 

date, Added date, or Changed date. Each group shows up as a collapsible bar in the main outline. Remember that in Planning view, the 

grouping applies to whole projects, not to the individual actions inside them.

Sorting

Click this to choose how to order the projects in the Planning view outline, or the actions in the Context view outline. If you have a grouping 

selected, the sorting happens inside the groups but the groups themselves stay in the same order.

In planning mode, you can leave projects Unsorted, or sort them by Name, whether they are Flagged, their Due dates, Start dates, 

Completed dates, Next Review dates, Added dates, or Changed dates.

In context mode, you can sort individual actions by the order of the Project they belong to, whether they are Flagged, their Due dates, 

Start dates, Completed dates, Added dates, Changed dates, or their Time estimates.
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Action Filter

Click this to choose what kind of actions of show in the main outline. You can choose to see All actions (regardless of their state), Next 

actions (just the next thing to do in each eligible project), Available actions (things you can actually do, because they aren't blocked by 

earlier actions in a sequential project), Remaining actions (anything that's not completed), or Completed actions (things you've already 

done).

Estimated Time Filter

Click this to show actions whose time estimates fall within a certain range. You can choose to find All actions (regardless of their time 

estimates), or actions that are estimated to take less than 5 minutes, less than 15 minutes, less than 30 minutes, less than 1 hour, more 

than 1 hour, or an Unknown amount of time (for actions you haven't estimated).

Flag Filter

Click this to show projects or actions based on whether they have flags set on them. You can choose to see All items (regardless of their 

flaggedness), Flagged items, or Unflagged items. Note that flagging an action puts a kind of ghost flag on its parent project, making the 

project count as flagged too, and flagging a project ghost-flags all of its contained actions.

Searching for actions or projects
The OmniFocus toolbar includes a Search field for filtering the main outline down to items that contain a certain string of text. As you type in 

it, items that don't match disappear dynamically. You can search based on action names, notes, context names, or project names.When 

you're done, click the clear button on the right side of the field and everything reappears.

OmniFocus also has a Find and Replace panel like many other applications, available from the Edit menu.

Using Perspectives to remember your OmniFocus window settings
You may find certain ways of setting up your OmniFocus window that are useful enough to make you want to come back to them again and 

again: your morning glance at what's due today, your weekly review, or your retrospective of what kind of things you've gotten done lately. 

With Perspectives, you can save view settings and get back to them whenever you like.

To create a perspective:

•Set up an OmniFocus window with the view mode, focused items, sidebar selection, and view bar settings just the way you like them.
•From the Perspectives menu, choose Save Perspective. (Or click the plus button in the Perspectives window.)
•In the panel that appears, type a name for your new perspective.
•If you want to give your new perspective a keyboard shortcut for easy access, click in the shortcut field and type a key combination.
•Click the Save button.

There are several ways to open a perspective:

<NO DATA>

To change a perspective:

<NO DATA>

To delete a perspective:

<NO DATA>

Reviewing projects
<NO DATA>

Marking a project complete
Eventually, oh frabjous day, you're going to reach the successful end of a project. When you're sure that you've really accomplished "move 

in to new house",
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Putting a project on hold
If you're not quite sure whether you want to start (or continue) a project, you can put it on ice for a while. It disappears from your Active 

Projects list in the sidebar, and its actions likewise stay hidden. Every now and then, you can set the project filter in the view bar to show On 

Hold Projects (or All Projects), and review which ones you'd like to make active, which ones you'd like to drop, and which ones you'd like to 

keep on hold.

There are several ways to put a project on hold:

•Select the project in the main outline, then use the Status control in the Project inspector to choose On Hold.

•Select the project in the sidebar, then choose On Hold from the gear menu at the bottom of the sidebar.
•Right-click or Control-click the project in the main outline or in the sidebar, then choose On Hold from the contextual menu.

To make an on-hold project active again:

•Choose On Hold Projects from the view bar's project filter pop-up menu.
•Find the project, then use one of the same techniques as above to set the project's status back to Active.

Dropping a project
If you've decided not to work on a project any further, you can drop it completely. It disappears from your Active Projects list in the sidebar, 

and its actions likewise stay hidden. Of course, you could just delete the project, but then you wouldn't have any record of it or its actions 

ever having existed. Keeping them around in a dropped state means you can go back and check on how often you give up on projects, 

check which actions you've completed regardless of whether they're from still-relevant projects, and so on.

There are several ways to drop a project:

•Select the project in the main outline, then use the Status control in the Project inspector to choose Dropped.
•Select the project in the sidebar, then choose Dropped from the gear menu at the bottom of the sidebar.
•Right-click or Control-click the project in the main outline or in the sidebar, then choose Dropped from the contextual menu.

To make a dropped project active again:

•Choose Dropped Projects from the view bar's project filter pop-up menu.
•Find the project, then use one of the same techniques as above to set the project's status back to Active.

Getting data into and out of OmniFocus

Printing
<NO DATA>

Clipping material from other applications
<NO DATA>

Synchronizing with iCal
<NO DATA>

Using the web interface
<NO DATA>.
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